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Chapter 1
Patient portal
 The patient portal is a web site that enables your patients to view certain areas of their medical 
chart online, including their:

 View and print their medical summary, current medications, vaccinations

 View their lab results and medical reports (documents)

 View, book, and cancel appointments online

 Receive messages from your clinic and automated notifications (such as to book 
appointments or come in for overdue tests)

 Send messages to your clinic

View video: Introduction to the patient portal 
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Patient portal
 

Your clinic can control the type of health information a patient can see and the actions a patient 
can perform in the patient portal. 

To use the patient portal, your clinic must register for this functionality. Contact TELUS Health for 
more information. 
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Chapter 2
Registering patients for the patient portal
You can register any patient for the patient portal as long as they have the following information 
entered in Patient Maintenance:

 Email address 

 Birth date

You can register only one patient at a time. When you register a patient, you choose which 
features the patient can access in the patient portal. For example, you can choose if a patient 
can book appointments online or send the clinic messages.

You can also register relations of a patient to access that patient’s patient portal. You must 
obtain legal consent from the patient to allow a relation to access the patient’s patient portal 
information. See ““Giving other people access to a patient’s data” on page 11”. 

Steps

1. Open the Patient Maintenance window for the patient.

2. On the Name/Addr/Phone tab, in the Communication area, enter the patient's email 
address in the eMail field.

Tip: When you add a new patient to Wolf EMR, be sure to record their email if they will 
likely use the patient portal (for example, patients with chronic diseases).

3. Click Save ( ).

View video tutorial: Registering patients for the patient portal 
Wolf EMR Patient Portal User Guide 7
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Registering patients for the patient portal
4. Click the Other Demographics tab. The patient portal area appears on the right side of 
the window.

5. In the patient portal area, click Settings. The Wolf patient portal Settings window 
opens. 
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Registering patients for the patient portal
6. In the Enable the following features for this user area, use the following table to select 
which features the patient can access in the patient portal. 

Option Description

Web 
Appointment 
Booking 

To enable the patient to book appointments online.

Rule Alerts To enable the patient to receive automated notifications when they 
are flagged by a patient portal rule.

Health 
Information Tab 

To enable the patient to view their health information (medical 
summary),

Messaging If your clinic is enabled for patient portal messaging, by default all 
patients enrolled in the patient portal can send you messages. The 
number of messages patients can send over a defined number of 
months is generally set in your clinic’s patient portal configuration. 
See “Configuring patient messaging” on page 98. 

However, if you want this patient to be able to send more or fewer 
messages than your clinic default:

1. Select the Override Message Default check box.

2. In the Patient is allowed to compose field, enter the number 
of messages the patient can send over a defined period of time.

3. In the messages in a rolling x month period field, enter the 
number of months that constitutes the defined period of time.
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Registering patients for the patient portal
7. Click Generate/Reset PIN. The EMR opens a PDF letter in the PDF-XChange Viewer. The 
body of the letter contains a message similar to the following example:

The EMR also sends an email message to the patient similar to the following: 

The patient needs both the printed letter and the email to sign up for the patient portal.

8. To print the letter, in the PDF-XChange Viewer window, click Print ( ), or on your 
keyboard, press Ctrl+ P.

9. Give the letter to the patient. The patient requires the Personal Identification Number (PIN) in 
the letter to sign up for the patient portal.
10 Wolf EMR Patient Portal User Guide



Registering patients for the patient portal
Note: The portal user should be present in person to get their PIN. Avoid faxing or emailing 
the letter containing the PIN.
The PIN generated in the letter is valid for only a certain number of days and your 
clinic can configure this duration (see “Configuring patient portal registration rules” on 
page 96”).

10.On the Wolf patient portal Settings window, click Save and Close ( ). 

11.Once the patient completes the registration process, the EMR displays a globe icon ( ) in 
the patient’s SMART patient banner to indicate that the patient has a patient portal account.

Giving other people access to a patient’s data
Patients can grant family members and other relations access to their patient portal. For 
example, an elderly patient with mild dementia can allow patient portal access to her daughter. 
Or, a young adult with a chronic condition can allow patient portal access to his mother.

The following steps describe how to grant a mother access to view her son’s patient portal 
information.

Steps

1. In the Patient Maintenance window, enter the mother into your Wolf EMR as a patient (if 
she is not already a patient. Ensure you enter the mother’s email address and date of birth in 
the Name/Addr/Phone tab, in the Communication area.

See “Patient Maintenance” in the Wolf EMR online help or user guide.

2. Link the mother and her son using patient relations:

a) Open the Patient Maintenance window for either the mother or son.
Wolf EMR Patient Portal User Guide 11



Registering patients for the patient portal
b) On the Name/Addr/Phone tab, in the Relationship area, click Add/Edit. The Patient 
Relations for <patient name> window opens.

c) In the Related Patient area, click Search. 

d) Search for and select the individual you want to create a relation to. The EMR displays 
the selected individual’s name in the Related Patient area.
12 Wolf EMR Patient Portal User Guide



Registering patients for the patient portal
e) In the Relation list, click the relationship the selected individual has to the patient.

f) In the Relation Status list, click the appropriate status for the relationship.

g) If the selected individual is the primary caregiver for the patient, in the Caregiver list, click 
Primary. 

h) Click Save. The EMR displays the relation in the Existing Relations area at the top of 
the window. 

i) Click Close ( ).

3. Set up mother with access to her son’s patient portal:

a) Open the Patient Maintenance window for the mother.

b) Click the Other Demographics tab. 

c) In the patient portal area, click Settings. The EMR displays the Wolf patient portal 
Settings window, with mother’s family members and other linked relations listed in the 
Proxy Access area.

Note: The Consent Required check box is selected if the patient is within the “Age of 
Consent”. For patients younger than the age of consent, this check box is not 
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Registering patients for the patient portal
selected as the patient is not required to sign a consent form. 

d) In the Proxy Access area, click the son’s name.

e) Click Print Consent Form. The EMR opens a PDF Consent Form in PDF-XChange 
Viewer. The body of the form contains a message similar to the following example: 

The patient can sign the consent form out of office if the form is appropriately witnessed. For 
example, if the patient is traveling, or is away at school.

Children younger than the age of consent do not have to sign a consent form for their 
parents or legal guardians, as consent is implied in this case. However, once the child 
reaches the age of consent, the child must then sign a consent form to enable their 
parent(s) to continue to access their patient portal.

Note: The “Age of consent” is determined and configured by your clinic. See “Configuring 
patient portal registration rules” on page 96.

f) To print the consent form, in the PDF-XChange Viewer window, click Print ( ), or 
press Ctrl+ P.

g) Have the son sign the consent form. To keep the signed consent form on file, scan the 
signed consent form, and then import it into the Documents area of the son’s medical 
summary.

h) Beside the son’s name in the Proxy Access area of the Wolf patient portal Settings 
window, select the Consent Obtained and the Access Portal check boxes.

i) If the other is not currently signed up for the patient portal herself, click Generate/Reset 
PIN. The EMR opens a PDF letter in the PDF-XChange Viewer.
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Registering patients for the patient portal
j) Print and hand the letter to the mother. 
Wolf EMR Patient Portal User Guide 15



Chapter 3
Sharing information with patients on the patient 
portal
You can choose to hide specific medication information from all or select users (see “Hiding 
medical information on the patient portal” on page 17).

You can then publish documents and lab information to patients through the patient portal (see 
“Publishing patient documents to the patient portal” on page 21).

You can send and receive messages to and from patients (see “Sending and receiving 
messages” on page 25).

Hiding medical information on the patient portal
By default, the patient portal displays the following “modules” of patient health information to 
registered users. Most information originates from the patient’s medical summary.

 General patient demographics

 Previous and upcoming appointments

 Current problems

 Current medications 

 Allergies

 Vaccinations

 Procedures and surgeries

 Social history

 Family history

 Harmful substances

 Other risks

 Investigations 

If you do not want patients to see all of the above information, you can customize what patients 
see. You can:
Wolf EMR Patient Portal User Guide 17



Sharing information with patients on the patient portal
 Hide select modules of health information for all patients.

 Hide select modules of health information for a particular patient.

 Hide select health information entries for a particular patient.

 Publish select documents for a particular patient.

 Publish investigations sooner or later than the standard “3 days after results are reviewed by 
the clinic”.

Hiding health information for all patients

Using security rules, you can specify what health information your patients cannot view in the 
patient portal. For example, if you don’t want patients to view information in the Social History 
area of their medical summary, you can hide this module for all patients.

If you later decide to show information that you hid to all patients on the patient portal, you can 
delete the security rule that you created to hide the health information.

Steps

1. On the Wolf EMR Home tab, click Configuration ( ). 

2. From the Configuration menu, choose View > Security > Security Rules. The Security 
window opens with the Security Rules tab selected.
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Sharing information with patients on the patient portal
3. In the Show Rules For list on the left side of the window, click patient portal.

4. Click New Security Rule. The New Security Rule window opens. 

5. In the Module list, click a module of the patient portal you want to hide.

6. In the Change Reason list, click the reason for the restriction. If you select Other, enter the 
reason in the Notes area.

7. In the Rule allows user/group to area, beside View, click No.

8. Click OK.

9. To hide other modules on the patient portal, repeat steps 4 to 8. 

10.To delete a security rule:

a) In the Show Rules For list on the left side of the window, click Patient Portal.

b) On the right side of the window, the EMR displays all Security Rules that are currently 
applied to the patient portal. 

Hiding select health information for one patient

You can control what health information a particular patient sees in the patient portal. For 
example, if a patient receives an abnormal lab result, you can hide the lab result on the patient 
portal until the patient discusses the result with their provider.   

Using patient data restrictions, you can:

 Hide an entire module of health information.

 Hide a specific data entry.

View video: Hiding health information in the Wolf EMR Patient Portal 
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Sharing information with patients on the patient portal
 Select how long a particular module or data entry remains hidden.

Steps

1. Open the Patient Maintenance window for the patient.

2. At the top of the window, click View > Patient Data Restrictions. The Data Restriction 
Maintenance window opens.

Note: If a window with the message “You do not have sufficient rights to edit access 
restrictions” appears, contact the Wolf EMR support team at 1-866-879-9653 
(Option 1). 

3. To hide an entire module of medical information, in the Module list in the Current 
Restriction Record area, click the module. For example, if you want to hide information on 
harmful substances from the patient, click Harmful Substances.

4. To hide only a specific entry in a health information module:

a) In the Current Restriction Record area > Module list, click Specific <module>, such 
as Specific Lab Results. The Restricted Data Record list opens.
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Sharing information with patients on the patient portal
b) In the Restricted Data Record list, click the specific data entry you want to hide. 

5. In the Security Group / Role list, click Patient Portal.

6. In the From and Up To fields in the Restriction Date Range area, enter the date range for 
the information to remain hidden from the patient.

Tip: To hide the health information for an indefinite amount of time, leave the Up To field 
blank.

7. In the Change Reason list, click Other, and then in the Notes area, type a reason for 
hiding the patient’s health information. 

8. In the Select (View) list in the Module Function Permissions area, leave No selected.

9. Click Save.

Publishing patient documents to the patient portal
By default, documents, such as medical reports, that reside in the Documents area of a 
patient’s medical summary are not visible to the patient. You must select what documents are 
to be published to the patient portal.
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Sharing information with patients on the patient portal
There are two areas in Wolf EMR where you can publish documents to the patient portal:

 In the Investigation/Document In Basket (enabling providers to publish new documents 
as they review them) 

 In the Documents tab of a patient’s medical summary.

Publishing new documents to the patient portal as you review them (providers)

Providers can publish new documents to the patient portal as they review them within the 
Investigation/Document In Basket. 

By default, labs are published to the patient portal 3 days after reviewing them, giving your clinic 
time to call-back patients for abnormal results, and to hide particular lab results from the portal if 
a provider wants to discuss a result with their patient in person first. You can change this default 
delay; see “Delaying publishing of reviewed labs to the patient portal” on page 24.

Steps

1. On the blue notification banner at the top of the WorkDesk, click < #> Documents (where 
<#> indicates the number of new documents available). The EMR displays the Investigation/
Document In Basket window.

2. To view a document, in your list of new documents, double-click the document. The EMR 
opens the document in an appropriate program for the file type. 

3. To post a document to the patient portal, in your list of new documents, click the document 
and select the Publish to Portal checkbox near the top right corner. 

4. To add a note for the patient regarding the particular document, type it in the Patient Notes 
field.
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Sharing information with patients on the patient portal
Publishing documents to the patient portal from the medical summary

From a patient’s medical summary, you can select one document or multiple documents at 
once to publish to the patient portal. 

Steps

1. In the patient’s medical summary, click the Documents tab.

2. Click Publish to Portal. 

The Publish documents to patient portal window opens with a list of the patient’s 
documents.

3. In the list of documents, select the check box beside documents you want to publish to the 
patient portal.
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Sharing information with patients on the patient portal
4. To add any notes to the patient regarding a particular document, in the Notes to Patient 
column, enter your notes to the patient.

5. When you are finished selecting documents, click Close ( ). The EMR confirms that the 
document(s) were published or updated to the portal. 

6. Click OK.

Delaying publishing of reviewed labs to the patient portal

After providers review labs, by default, labs are not published to the patient portal for 3 days. 
This delay in lab publishing gives your clinic time to call-back patients for abnormal results, and 
to hide particular lab results from the portal if a provider wants to discuss a result with their 
patient in person first. 

You can change the number of days until reviewed lab results (for all patients) are published to 
the patient portal.

Steps

1. From the Wolf EMR Home page, click the Maintenance tab. 

2. On the Maintenance toolbar, in the Patient Portal area, click Configure Web Content 

( ). The Patient Portal Content and Configuration Form window opens.

3. In the column along the left side of the window, click Lab Result Configuration, and then 
click Labs Display Rules.

4. In the Number of Days Past Review Date to Publish to Patient Portal field, type the 
number of days.
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Sharing information with patients on the patient portal
5. When you are finished, perform one of the following actions:

 To apply your changes to the patient portal now, click Apply ( ).

 To save your changes, but not apply the changes to the patient portal, click Save and 

Close ( ). 

 To close the window without saving your changes, click Close ( ).

Sending and receiving messages
If your clinic is set up for patient portal messaging, you can:

 Send messages to patients 

 Delete messages that were sent to patients

 Track if patients have viewed their messages

 Receive messages from patients (if you are a provider)

Sending messages to patients

Any clinic user can send a message to a patient via the patient portal. When you send a 
message to a patient, you are indicated as the sender. You cannot send a message on behalf 
of another user. You send messages to patients using the same messaging system you use to 
send messages to clinic members in Wolf EMR. 

When patients receive a patient portal message, they are notified by email. Patients can then 
log into the patient portal to view their message(s). You can specify whether the patient is able 
to reply to your message (instead of having to call the clinic).

You can automatically track messages sent to patients and create a follow-up task if the patient 
does not view, reply, or book an appointment within a set period of time after receiving your 
message. This enables you to track non-action by patients and automatically assign the follow-
up task to someone in your clinic for further action.

For example, you send a message to a patient asking them to provide you with information by 
replying to the message within 48 hours. When creating the message, you click the new Portal 
Tracking button, and then specify that if the patient does not take this action, a front-end staff 
member is notified.

Steps

1. Open any window of the patient’s chart (for example, the medical summary or a SOAP note).
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Sharing information with patients on the patient portal
If the patient is a patient portal user, the EMR displays a patient portal icon ( ) in the SMART 
patient banner.

2. Right-click and then, in the SMART menu, click New Message. The New Message For: 
<patient name> window opens.

3. In the To area, click Patient. The EMR displays options for publishing the message to the 
patient portal.

Note: If the patient portal messaging options do not display, the patient is likely not set up 

as a patient portal user. Ensure the patient portal icon ( ) is displayed in the SMART 
patient banner. See “Registering patients for the patient portal” on page 7.

4. Select the Publish to Portal check box. The EMR selects your name in the From area. You 
cannot send messages on behalf of someone else.

5. In the Regarding field, type the reason or subject for the message.
26 Wolf EMR Patient Portal User Guide



Sharing information with patients on the patient portal
6. In the Message area, type the message body.

7. If you want to enable the patient to reply to the message, select the Allow Reply check 
box. The patient will see a reply button in the message and the reply will go directly to you, 
the sender.

8. To track the message and create a follow-up task if the patient does not action the message 
within a set period of time:

a) Click Portal Tracking. The Portal Message Tracking window opens. 

b) Specify the recipient of the follow-up task, action that the patient must take, and the 
period within which they must take action.

The default recipient is the follow-up default recipient specified within your WorkDesk 
user preferences.

c) Click Save. Information about the tracking is saved within the message log and details.

9. Click Close & Save Message ( ). The EMR sends an email to the patient indicating 
that a message is available in the patient portal. The patient can log into the patient portal to 
view the message. See “Viewing messages from patients” on page 29.

Verifying that a patient has viewed a message

You can verify that a patient has viewed a specific message by looking at the log information. 
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Sharing information with patients on the patient portal
You can also automate the creation of a follow-up task if the patient has not viewed the 
messages (see “Sending messages to patients” on page 25).

Steps

1. Open the message: 

a) Open the patient’s medical summary. 

b) Click the Communications tab. The EMR displays a list of the patient’s completed and 
outstanding messages in the left pane.

Note: All patient portal messages are marked as complete (as indicated by a C to the 
left of the message) as soon as they are sent to a patient.

c) Double-click the message. The EMR displays the Patient Message for <patient 
name> window, with the selected message’s details displayed in the right pane. 

2. In the Log area of the message, scroll down to view information on:

 When the message was sent and who sent the message

 The date and time that the message was opened 
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Removing a message from the patient portal

If you send a message in error (for example, if you send a message to the wrong member of a 
family), you can remove the message from the patient portal.

Steps

1. Open the message: 

a) Open the patient’s medical summary.

b) Click the Communications tab. 

Note: The EMR displays a list of the patient’s completed and outstanding messages in 
the left pane.vAll patient portal messages are marked as complete (as indicated 
by a C to the left of the message) as soon as they are sent to a patient.

c) Double-click the message. The EMR displays the Patient Message for <patient 
name> window, with the selected message’s details displayed in the right pane.

2. At the bottom of the message detail area, clear the Publish to Portal check box. 

3. Click Close Form ( ). 

Viewing messages from patients

Only providers can receive patient portal messages from patients. Messages from patients 
appears in your Wolf EMR messages list. If you are a provider and you do not want to manage 
messages originating from the patient portal, you can redirect them to your front-end staff.
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Steps

1. Open your outstanding Wolf EMR messages: Open the WorkDesk, and then on the blue 
banner (located at the top of the window), click # Current Messages (where # = the 
number of your outstanding messages). 

2. In your list of outstanding messages, click a message that contains a patient name in the 
From column. The EMR displays:

 The message title: Patient Message for <patient name> at the top of the window

 The message contents in the right pane 

 Patient portal beside Entered by 

3. Perform one of the following actions:

 To redirect the message to another staff member, click ReDirect.

 To mark the message as viewed and to remove the message from your list of 
outstanding messages, click Completed.

Note: You cannot reply directly to the patient from the message. Instead, you must 
compose a new message to the patient. See “Sending messages to patients” on 
page 25.
30 Wolf EMR Patient Portal User Guide



Chapter 4
Using the patient portal (patient perspective)
To gain access to the patient portal, you must receive an invite from your clinic. The clinic gives 
you a paper registration letter, and sends you a registration email. Do not throw the letter away 
as you need the PIN to sign into the patient portal for the first time.

Following is an example of the email you receive. 

The registration email provides you with a link to the clinic’s patient portal website. 

Tip: Add the patient portal link to your web browser favourites so you can easily access the 
website going forward.

Steps

1. Open a web browser, and then go to the clinic’s patient portal website address. 
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2. In the login page, type your user name and password, and then click Log In. 

Viewing your health information
In the patient portal you can view select portions of your health information and the health 
information of other patients you have access to. The available health information is read-only; 
you cannot modify or respond to health information in the patient portal. 

Steps

1. At the top of the patient portal, click the Health Information tab. The Health Information 
page opens with:

 A list of available profiles listed at the top of the page (if you have access to other patient’s 
health information). 
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 A menu of available health information along the left side of the window. 

2. If you have access to other patients’ health information, in the Available Profiles list, click 
the patient you want to view health information for.

Note: Your health information displays by default. The clinic sets up available profiles. If you 
want to view health information for a relation that is not listed, you must receive 
consent from the patient and request access from the clinic.

3. In the menu on the left side of the window, click the type of health information you want to 
see. 

Health Summary page

The Health Summary page shows a summary of your current health information, including:

 Your next and last appointment date and time 

 You recent booking activity 

 Current conditions 

 Current medications

 Vaccinations
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 Allergies and adverse reactions 

Health History page

The Health History page displays a summary of your past health information, including:

 Inactive conditions (for the past 5 years – by default)

 Previous medications (for the past 5 years – by default)

 Procedures

 Inactive allergies and adverse reactions
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Data View

Displays health history information in a list format.

Timeline View

Displays both your historic and current health information in a graphical format. The timeline 
includes:

 Appointment dates and details

 Examination dates with some details (including height, weight, BMI)

 Vitals (including blood pressure, temperature, and pulse)

 Investigations (including hemoglobin, mononucleosis [MONO] Test, carboxy-
tetrahydrocannabinol confirmation [THC], white blood cell count [WBC])
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 Diagnosis dates for conditions 

To navigate the timeline:

1. To scroll backwards or forwards on the graph, in the grey area below the graph, click and 
drag your cursor. The timeline moves with your cursor.

2. To view details for a specific appointment or examination listed in the grey area of the 
timeline, click the appointment or examination text. The timeline displays the details for the 
appointment or examination. 
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3. To view details for a specific data point on the graph, hover your cursor over the point. The 
timeline displays the date and data value. 

4. To include a particular vital or investigation on the graph, click one of the color-coded fields 
at the top of the graph and then, in the list of available vitals and investigations, click the 
value you want to graph. 

Results page

The Results page displays your lab and other investigation results for the past 5 years (by 
default). You can view your results using two different view options.
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Data View 

Displays your results in a table with the test date, type, result, result range, and whether the 
result was abnormal.  

To change the sort order of the table, click a column heading. 

The page sorts the result by the contents of the selected column.

To categorize the results, click a column header and drag it to the area above the table. The 
page categorizes the results by the contents of the selected column. 
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For example, if you categorize results by test, the table displays all results for each test together:

To change the order of the table columns, click a column header and drag it to where you want 
the column to display.

Graph View

Displays your results in the form of a graph. From the top, select the measure that you want to 
graph. 
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Click or hover your mouse over a data point to see the date and time of the result. The normal 
range appears next to the measure name at the top and within the graph.

Documents area

The Documents area displays a list of your health documents, such as medical reports, 
requisition forms, and consult letters.

Click the document to open it in a separate window or tab in your internet browser.

Troubleshooting: What if the document does not open? 

Your web browser is likely out of date. Try opening the patient portal in another web 
browser, or update the browser you are currently using.
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Appointments page

The Appointments page displays a summary of your upcoming and past appointments in a 
table format. 

Personal Info page

The Personal Info page displays your contact information and other personal information. If 
your contact information is out-of-date, contact the clinic to inform them of the change. You 
cannot edit your personal information in the patient portal. 

Printing your health information
You can print your patient portal health information in a printer-friendly format. Available reports 
include the:

 Summary Report: Prints your current health information, including vaccinations, allergies, 
current conditions, and current mediations.

 Medication Report: Prints your current medications, past medications, and allergies.

 Vaccination Report: Prints your recorded vaccinations.
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Steps

1. Navigate to the Health Information tab of the patient portal.

2. In the left pane, in the Printable Reports area, click the report you want. The page displays 
the selected report in a PDF view. 

3. Perform one of the following actions:

 To print the full report, click Print ( ).

 To print only the page displayed, click Print the current page ( ).

 To save the report to your computer, click Export report and save it to the disk ( ).

 To view the report in its own browser window and view or print it from there, click Export 

a report and show it in a new window ( ).

Notifications
In the Notifications area you can view any notifications sent from the clinic. The types of 
notifications you can receive include:

 Reminders that you are due for preventive care or disease management tests 

 Reminders that you are due for follow up appointments 
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 Tips for managing your health 

Booking appointments
Through the patient portal you can book appointments with a provider.

Steps

1. Log into the patient portal, and at the top of the window, click Book an Appointment. 

2. If you have access to other patients’ health information, in the For whom are you making 
the appointment? list, select the patient you want to book the appointment for. Select the 
reason for the appointment, and then click Next. 

Tip: The options available in the reason for appointment area are determined by the 
clinic. See “Enabling specific types of appointments to be booked online” on page 
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83.

3. If you have access to multiple clinic locations, click the location you want and, in the Based 
on the location you selected, who would you like to see for your appointment? list, 
select the provider you want to book the appointment with and then click Next. 
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4. On the calendar, click the date when you want to book the appointment and to the right of 
the time slot you want, click Select Time.

Tip: To change the calendar month, use the arrows to move back or forward a month.
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5. Review the details of the appointment. Make sure you review the clinic’s cancellation policy. 
Pay special attention to important details such as cancellation or no-show charges.

6. In the Are there any other details you wish to specify for this appointment? field, type 
any additional appointment notes.

7. By default, the EMR sends you a confirmation email with your appointment details. If you do 
not want to receive an email, clear the Send Email of this Appointment to my Email 
Account check box.

8. Click Book It! The patient portal sends you a confirmation email containing your 
appointment details (unless you opted out of receiving an email).

9. To add the appointment to your email calendar, click Add to Calendar. This is compatible 
with most of the commonly used calendar applications, including Google calendar, Outlook, 
yahoo, Hotmail, and iCal (Mac).

Canceling appointments
In the patient portal, you can view a list of your upcoming appointments. From your upcoming 
appointment list, you can choose to cancel an appointment.
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Before you cancel an appointment, review the clinic’s cancellation policy. Pay special attention 
to important details such as cancellation or no-show charges. 

Steps

1. At the top of the patient portal page, click the Upcoming Appointments tab.

Tip: If you are canceling an appointment for a patient other than yourself, you must first 
change to that patient’s profile. Click the Health information tab and then, in the 
Available Profiles list, select the patient.

2. To the right of the appointment, click Cancel. 

3. Review the details of the appointment you are canceling.

4. In the Special Instructions/Information area, type your reason for canceling the 
appointment.

5. Click Cancel Appointment. When prompted, click Continue. The Portal displays a dialog 
box with the following prompt: 
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Sending and receiving messages
Clinic providers and staff can send you personalized messages via the patient portal. When you 
receive a message, you are notified by email. The email does not contain the message itself, 
instead the email prompts you to log in to the patient portal to view the message.

Depending on the clinic’s processes, you may also be able to send a limited number of non-
urgent messages to the clinic via the patient portal. If you are restricted to a certain number of 
messages, the patient portal indicates how many you can send over a defined period of time.

 Once you reach your maximum allowed messages, you are unable to create a new message 
until the next time period.

Important: For urgent matters, always contact the clinic by phone.

Viewing messages

When you view a message in the patient portal, the clinic is notified that you viewed it. There 
may also be a Reply button if the sender requested you to reply through the portal.

Steps

1. Log into the patient portal and on the home page, click the Messages (#) tab (where # = 
the number of messages you have). 

2.  In the list of messages, click the message you want to view. The patient portal displays the 
message contents, including who sent the message and the date it was sent.
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Sending messages

If you have permissions from your medical clinic, you can send messages to them through the 
patient portal.

Steps

1. At the top of the patient portal page, click the Messages tab. 

2. In the left pane, click Compose New Message. The Compose New Message area 
indicates how many messages you can send.

3. In the This message is regarding whom? list, select the patient.

4. In the Message area, type your message.

5. Read the information displayed in the orange dialog area, and then select the I have read 
and understand the information described above check box.

6. Click Send.
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Managing your patient portal account
Through the Your Account page of the patient portal, you can:

 Change your password and set your password recover security questions: If you forget your 
password, you can answer a series of pre-configured questions to reset your password and 
regain access to your account. You can modify these password recovery questions at any 
time.

 Deactivate your account: If you leave the clinic, or if you want to stop online access to your 
health information for any reason, you can deactivate your patient portal account. When 
deactivating your account, you delete only your portal credentials. All of your patient data 
remains on the clinic’s system. 

If you later change your mind, contact the clinic to reactivate your patient portal account.

 Turn on or turn off email notifications for appointment reminders

Steps

1. In the top right of the patient portal, click Your Account. 

2. To change your password:

a) Next to Security, click Change Password. 

b) In the Change Password page, type your current and new password and click Submit. 

Note: Your password must include three of the following four requirements: 
Uppercase letter (A to Z)
Lowercase letter (a to z)
Number (0 to 9)
Special character (such as ! @ # $).

3. To change your password recovery options: 

a) Next to Security, click Change Password Recovery Options. 

b) In one of the Security Question lists, click a question.

c) In the Security Answer field, type the answer. and click Submit.
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4. To deactivate your account, next to My Profile area, click Deactivate. 

5. To turn on or off your appointment reminder notifications, next to Appointment Reminders, 
click Turn OFF or Turn ON.
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Chapter 5
Managing the patient portal (Administrators)
 “Customizing the patient portal colour scheme” on page 53

 “Adding your clinic’s logo to the patient portal” on page 60

 “Customizing your patient portal web page content” on page 62

 “Configuring online appointment booking” on page 75

 “Tracking cancelled appointments” on page 103

 “Patient portal reports” on page 106

Customizing the patient portal colour scheme
You can customize the colour scheme and logo of your clinic’s patient portal. The patient portal 
comes with two pre-defined styles you can choose from:

 Base Default: Has a blue/grey colour scheme

 TELUS Style: Has a green/purple colour scheme

You can also create your own colour scheme, to mimic the look and feel of your current clinic 
web site. 

The following table describes the different colour settings you can customize. 
Item Description

Form Styling 
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Title Color Page title colour for all patient portal pages. In most cases, the page title 
is the patient’s name. 

Description 
Color 

Instructions to the user. 
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Primary Button 
Color 

Primary Button 
Text 

Default Button 
Color 

Default Button 
Text 

Some patient portal pages contain buttons you can click to perform an 
action. For example, to confirm that you want to book an appointment, 
you click the Book it button. 

If there are multiple buttons to choose from, one button is defined as the 
default button. It is the button that is clicked most often, and his 
highlighted by default.

The default button displays with the Default Button Color as the 
background, and the Default Button Text as the text colour. 

All other buttons display with the Primary Button Color as the 
background, and the Primary Button Text as the text colour. 

Border Defines the border colour outlining the patient portal pages.

Tables 
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Header 
Background 
Color 

Header Text 
Color 

Row Band 
Color 

Row Alternate 
Band Color 

For portal pages that contain information in a table, such as lab results, 
you can configure the colour and background of the header. 

You can distinguish rows by alternating background colours. 

Call to Action Banner 

Text Color 

Background 
Color 

The Call to Action Banner appears near the top of the patient portal to 
provide notifications to patients, such as:

 They can now perform an action (for example, if they can start a 
scheduled video conference)

 They performed an action incorrectly (for example, if they entered the 
wrong user name and password)  

Main Horizontal Tab 
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Main Tab Color 

Main Tab Active 
Color 

Main Tab Text 
Color 

In the horizontal menu at the top of all patient portal pages, the clickable 
tabs have the Main Tab Color as background colour, and the Main 
Tab Text Color as text colour.

Once you click a tab, the background colour of the tab changes to the 
Main Tab Active Color. 

Use Folder Tab Select to have tabs at the top of the patient portal (Home, Health 
Information, etc.) display in a file folder-like format instead of as simple 
buttons.

Side Panel 

Active Color 

Active Text 
Color 

When you click the menu on the left side of the patient portal, the 
selected item highlights with the Active Color, and the item’s text 
changes to the Active Text Color.  

Links 
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Steps

1. From the Wolf EMR Home tab, click the Maintenance tab. 

Link Text Color 

Active Link Text 
Color 

Links on the patient portal are displayed in the Link Text Color.

Once you a link, the link text changes to the Active Link Text Color. 

Availability Calendar 

Date Avail 
Background 
Color 

Date Avail Text 
Color 

Selected 
Background 
Color 

Selected Text 
Color 

When a patient books an appointment, they choose a date from a 
clickable calendar. 

Active link text 
(currently selected)

Link text
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2. Within the Patient Portal area, click Configure Web Style ( ). The Patient Portal 
Style Management Form window opens. 

3. Under Theme, in the Predefined Styles list, complete one of the following actions:

 To customize the colour scheme of your clinic’s patient portal, select Clinic Custom 
Style.

 To use a pre-defined colour scheme, select Base Default (for grey/blue colours), or 
TELUS Style (for green/purple colours).

Note: You cannot alter the colour schemes for the Base Default and Telus Style 
predefined styles. 

4. If you are customizing your colour scheme, select appropriate colours for each area. 
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a) Click the drop-down list to the right of the item you want to change and click the colour 
you want. 

b) If the colour you want is not displayed, or to specify an exact colour, click More Colors 
and specify your new colour code.

Tip: If you want to mimic the colour scheme of your clinic’s website or logo, you can 
determine HEX colour codes for your colours using one of many free applications 
available online (such as ICONICO’s ColorPic application: http://www.iconico.com/

colorpic ).

5. When you are finished, complete one of the following actions:

 To apply your changes to the patient portal and leave the window open, click Apply ( ).

 To apply your changes to the patient portal and close the window, click Save and Close 

( ). 

 To close the window without saving your changes, click Close ( ).

Adding your clinic’s logo to the patient portal
You can further customize the patient portal to contain your clinic’s logo. You can add your 
clinic’s logo to:

 The top of the patient portal web site 

 The header of reports printed from the patient portal
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For optimal image quality, use only .jpg or .png images and size your clinic logo to be 250 pixels 
wide x 100 pixels high.

You must save your logo image file on your Data Center remote desktop before you can import 
it into Wolf EMR. Copy and paste the image file from your local computer to the remote 
desktop.

Steps

1. On the Wolf EMR Home page, click the Maintenance tab. 

2. In the Patient Portal area, click Configure Web Content ( ).The Patient Portal 
Content and Configuration Form window opens. 

3. In the left column, click Portal Logos. 

4. To add your logo to your patient portal site header:

a) Under Header Logo, click Change Header Logo. The EMR displays a file search 
window.

b) Find your logo image file, and then click Open. The EMR displays a sample of your logo.

5. To add your logo to reports printed from the patient portal:

a) Under Report Logo, click Change Report Logo. The EMR displays a file search 
window.

b) Find your logo image file, and then click Open. The EMR displays a sample of your logo.

6. Perform one of the following actions:
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 To apply your changes to the patient portal and leave the window open, click Apply ( ).

 To apply your changes to the patient portal and close the window, click Save and Close 

( ). 

 To close the window without saving your changes, click Close ( ).

Customizing your patient portal web page content
During the patient portal implementation process you are asked to complete the Wolf EMR 
patient portal Configuration Questionnaire. In the questionnaire you are asked to review 
the default patient portal web page content and to provide feedback on changes you want. 
Prior to implementation, the TELUS Health team configures your patient portal to reflect your 
changes.

If you later want to make changes to your legal messages, you can change them on the patient 
portal Content and Configuration Form window.

Customizing legal messages

When a patient views their health information in the patient portal, a legal message displays at 
the top of each page. For example, the Health Summary page may state the following legal 
message: “Results displayed below should not be considered a diagnosis or prognosis. Your 
care provider assesses this information in conjunction with your medical history when 
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considering your care plan. If you notice any discrepancies or errors in your record, please 
highlight them to your provider at your next visit.” 

The patient portal contains default legal messages; however you can modify your legal 
messages at any time. The following page sect ions of the Health Information tab have 
unique, customizable legal messages: 

 Health Summary

 Health History – Data View

 Health History – Timeline

 Results – Data View

 Results – Graph View

 Documents

 Appointments

 Personal Info

 Notifications

Steps

1. On the Wolf EMR Home page, click the Maintenance tab. 

2. In the Patient Portal area, click Configure Web Content ( ).The Patient Portal 
Content and Configuration Form window opens.
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3. In the left column, click Health Information Legal Messages. The EMR expands the 
menu to display a list of pages that contain legal messages.

4. In the list of pages, click the page you want to edit the legal message for. The EMR displays 
all current legal messages on the right side of the window, with the selected page’s legal 
message highlighted. 

5. Edit the legal message as needed. You can review and modify all your legal messages at 
once by scrolling down. 

6. Perform one of the following actions:

 To apply your changes to the patient portal and leave the window open, click Apply ( ).

 To apply your changes to the patient portal and close the window, click Save and Close 

( ). 

 To close the window without saving your changes, click Close ( ).

Customizing the Frequently Asked Questions page

The Frequently Asked Questions (FAQ) patient portal page assists patients with navigating and 
using the portal. All portal pages have a link to the FAQ.
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As more of your patients use your patient portal, you may find that new questions and answers 
need to be added, or that currently available questions and answers need to be modified. For 
this reason, you can add to or modify your FAQ page.

To add or edit the FAQ content, you must edit the HTML code that appears on your patient 
portal.

Note: If you are not knowledgeable in HTML, avoid changing HTML text you do not 
understand. To request that TELUS Health add, modify, or delete content for you, 
contact the Wolf EMR support team. 

Steps

1. On the Wolf EMR Home page, click the Maintenance tab. 

2. In the Patient Portal area, click Configure Web Content ( ).The Patient Portal 
Content and Configuration Form window opens.

3. In the left column, click Custom Page Content (HTML).

 The EMR expands the menu to display a list of configurable patient portal pages.

4. In the list of configurable pages, click FAQ Page Content. The EMR displays all Custom 
Page Content items on the right side of the window with the FAQ Page (HTML) area 
highlighted. 
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The FAQ Page Content area displays HTML code similar to the following: 

 HTML text that begins with <span> and ends with </span> represents text you see 
on the page.

 HTML text that is preceded with an <h5> line and followed by an </h5> line displays 
as a header (question) on the page.

 HTML text that is preceded with an <p> line and followed by an </p> line displays as 
the paragraph content (answer) on the page.

 HTML text with the format ${item} is information that the page pulls from your EMR 
automatically. For example, ${clinic_phone} tells the page to pull your clinic phone 
number from your EMR. If you change your clinic phone number in Wolf EMR 
Configuration, the page then reflects the change automatically. CAUTION: avoid 
editing these items.

Question

Answer
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This is how the FAQ appears on the patient portal:

5. To modify a question on the FAQ page, edit the text within <h5><span> and </h5></
span>.

6. To modify an answer on the FAQ page:, edit the text within <p><span> and </span></p>.

7. To add a question to the FAQ page, copy an existing question and answer (from 
<h5><span> to </span></p>) to where you want the new question, and edit the text as 
needed.

8. Perform one of the following actions:

 To apply your changes to the patient portal and leave the window open, click Apply ( ).

 To apply your changes to the patient portal and close the window, click Save and Close 

( ). 

 To close the window without saving your changes, click Close ( ).
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Customize the Terms and Conditions page

The Terms of Use page describes the terms and conditions patients must agree to in order to 
use the patient portal. 

Your patient portal is implemented with a minimum set of terms and conditions, with additional 
terms and conditions added at the request of your clinic during the implementation process.

If you later decide to add additional terms and conditions, you can either modify the Terms and 
Conditions page yourself (if you know HTML), or you can send a request to the TELUS Health 
team to make the changes for you.

Note: If you are not knowledgeable in HTML, avoid changing HTML text you do not 
understand. To request that TELUS Health add, modify, or delete content for you, 
contact the Wolf EMR support team. 

Steps

1. On the Wolf EMR Home page, click the Maintenance tab. 

2. In the Patient Portal area, click Configure Web Content ( ).The Patient Portal 
Content and Configuration Form window opens.
68 Wolf EMR Patient Portal User Guide



Managing the patient portal (Administrators)
3. In the left column, click Custom Page Content (HTML) > Terms and Conditions Page 
Content. 

The Terms and Conditions Page area displays the page’s content in HTML. Various 
paragraphs and lines of the terms of use content are preceded by HTML defining the 
paragraph’s or line’s font and formatting.

4. In HTML format, enter additional terms and conditions as needed.

5. Perform one of the following actions:

 To apply your changes to the patient portal and leave the window open, click Apply ( ).

 To apply your changes to the patient portal and close the window, click Save and Close 

( ). 

 To close the window without saving your changes, click Close ( ).

Customize the Privacy Policy page

Your clinic is responsible for developing and upholding an appropriate patient portal privacy 
policy for your patients. 
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Your patients can easily access this policy through the Privacy Policy link located at the 
bottom of each page of the portal. 

Your patient portal is implemented with a privacy policy initially provided by your clinic. You can 
later decide to add or modify it.

Note: If you are not knowledgeable in HTML, avoid changing HTML text you do not 
understand. To request that TELUS Health add, modify, or delete content for you, 
contact the Wolf EMR support team. 

Steps

1. On the Wolf EMR Home page, click the Maintenance tab. 

2. In the Patient Portal area, click Configure Web Content ( ).The Patient Portal 
Content and Configuration Form window opens.
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3. In the left column, click Custom Page Content (HTML) > Privacy Policy Page Content. 

The Privacy Policy Page area displays the page’s content in HTML. Various paragraphs 
and lines of the content are preceded by HTML defining the paragraph’s or line’s font and 
formatting.

4. In HTML format, modify or enter additional items as needed.

5. Perform one of the following actions:

 To apply your changes to the patient portal and leave the window open, click Apply ( ).

 To apply your changes to the patient portal and close the window, click Save and Close 

( ). 

 To close the window without saving your changes, click Close ( ).

Customizing the Contact Us page

The patient portal Contact Us page displays your clinic’s:

 Clinic hours

 Email (if applicable)

 Phone number

 Address
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 Google map of your location 

Your patient portal is implemented with your clinic hours, address, contact information, and any 
other contact notes already set. You can update this information on the patient portal as 
needed.

The patient portal pulls your clinic’s address, phone number, and email from your Wolf EMR 
Configuration window. If you move locations, add an email, or change your phone number, you 
can modify your clinic contact information in your EMR (Configuration > Clinic Address/
Phone tab). The patient portal then updates your contact information and Google Map 
automatically.

If you change your clinic hours, you must update the Contact Us portal page directly.

Note: If you are not knowledgeable in HTML, avoid changing HTML text you do not 
understand. To request that TELUS Health add, modify, or delete content for you, 
contact the Wolf EMR support team. 

Steps

1. On the Wolf EMR Home page, click the Maintenance tab. 

2. In the Patient Portal area, click Configure Web Content ( ).
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3. In the left column, click Custom Page Content (HTML) > Contact Us Page Content. 

The Contact Us Page area displays the page’s content in HTML.  

4. To locate your clinic hours, scroll down the HTML text. Your clinic hours display similar to the 
below example, with each line of your clinic hours preceded by the text <dd> and followed 
by the text </dd>. 

5. Modify the text of each line of your clinic hours (between <dd> and </dd>) as needed.

6. Perform one of the following actions:

 To apply your changes to the patient portal and leave the window open, click Apply ( ).

 To apply your changes to the patient portal and close the window, click Save and Close 

( ). 

 To close the window without saving your changes, click Close ( ).
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Customizing the Home page

The Home Page is the first page your patients see every time they log into the patient portal. It 
provides a brief overview of the information available to patients on the portal. It can also act as 
an “announcement board” for general clinic communications to patients. 

The below example demonstrates how the home page can provide customized clinic 
announcements. 

Note: If you are not knowledgeable in HTML, avoid changing HTML text you do not 
understand. To request that TELUS Health add, modify, or delete content for you, 
contact the Wolf EMR support team. 

Steps

1. On the Wolf EMR Home page, click the Maintenance tab. 

2. In the Patient Portal area, click Configure Web Content ( ).
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3. In the left column, click Custom Page Content (HTML) > Home Page Content. 

The Home Page area displays the page’s content in HTML. 

4. In HTML format, modify or enter additional Home Page content as needed.

5. Perform one of the following actions:

 To apply your changes to the patient portal and leave the window open, click Apply ( ).

 To apply your changes to the patient portal and close the window, click Save and Close 

( ). 

 To close the window without saving your changes, click Close ( ).

Configuring online appointment booking
Through the patient portal, your patients can book appointments online. When a patient books 
an appointment online, the provider’s Wolf EMR appointment scheduler is updated immediately 
with the new appointment.

The online appointment booking tool is configurable, enabling you to customize online booking 
to meet the needs and comfort level of your clinic. Your clinic can configure:

 How many appointments each patient can book online.

 How many online appointments a patient can book for a specific day.
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 Whether to send appointment reminders by email

 How soon and how far in advance patients can book appointments online.

 Which of your providers can receive online appointment bookings.

 What time slots can and cannot be booked online.

 What types of appointments can be booked online.

Setting clinic-wide online appointment booking rules and email reminders

You can configure how many appointments each patient can book online for a particular 
provider and per day. 

You can also automatically send appointment reminders to patients for upcoming reminders. 
Patients can always choose to opt out of receiving these reminders (within their My Account 
patient portal account settings), for example, if they have a weekly appointment with you. 
Patients receive an email with the following text:

Subject for advanced: Reminder - Appointment at <ClinicName>

Subject for imminent reminders: Final Reminder - Appointment at <ClinicName>

Dear <UserFirstName UserLastName>, we are writing to remind you about the following 
appointment for <PatientName&gt; with <Provider Full Name>, Credentials> at <Clinic 
Name>
Date: <ApptDate>
Time: <ApptTime, Timezone>
Address: <LocationAddress>
<Maplink>

Remember, you can book or cancel appointments online in your <ClinicName> Patient 
Portal account, login here <login link>.

Steps

1. On the Wolf EMR Home page, click the Maintenance tab. 

2. In the Patient Portal area, click Configure Web Content ( ).The Patient Portal 
Content and Configuration Form window opens.
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3. In the left column, click Appointment Booking Rules > Appointment Booking Rules. 

4. In the Maximum number of web bookable appointments field, enter the maximum 
number of appointments a patient can book online for a particular provider.  

Once a patient reaches their maximum number of appointments, they cannot book another 
appointment online with that provider until at least one of their currently booked 
appointments is marked as Confirmed in Wolf EMR.

5. In the Maximum number of bookable appointments per day field, enter the maximum 
number of appointments a patient can book online for one calendar day for a particular 
provider.

Tip: If you do not want to restrict online appointment bookings, then leave one or both of 
the fields blank.

6. In the Appointment Reminder Email Configuration area, specify whether to send 
advance and imminent reminders, and specify how many hours in advance of the 
appointment to send the reminders.

7. Perform one of the following actions:

 To apply your changes to the patient portal and leave the window open, click Apply ( ).
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 To apply your changes to the patient portal and close the window, click Save and Close 

( ). 

 To close the window without saving your changes, click Close ( ).

Setting up a provider’s schedule for online appointment booking

Your clinic has complete control over how and when patients can book appointments online. 
Before you plan how to best configure online appointment booking to meet the needs of your 
clinic, consider the following questions:

 What types of appointments do you want patients to be able to book online? (For example, 
should patients be able to book appointments such as physicals or prenatal visits online?)

 Can patients book last minute appointments online? Or must they book a certain number of 
days in advance? 

 How far in advance do you want a patient to be able to book an appointment online?

 Are there specific days in the week or certain time slots in a day where you do not want 
patients to be able to book an appointment online? (For example, do you want to restrict 
online bookings for days of the week your clinic tends to receive more walk-ins?)

Configure a provider’s schedule for online booking involves the following tasks:

 “Creating “web-bookable” schedule time types” on page 78

 “Enabling specific types of appointments to be booked online” on page 83

 “Enabling specific days and time slots for online booking” on page 85

Creating “web-bookable” schedule time types

You should create a specific schedule time type for the purpose of defining web-bookable time 
slots. Name this schedule time type “Web Appt”, “Online Appt”, or something similar.

Clinics with multiple providers on different time intervals

If you have multiple doctors on different schedule intervals, create a separate schedule time 
type for each interval.

For example, in a multi-doctor clinic, Doctor A has 10-minute appointment slots and Doctor B 
has 15-minute appointment slots. The clinic creates two schedule time types to define “Web 
Bookable” appointments for each provider:

 Web Appt 10– To define “Web Bookable” appointments for Doctor A.

 Web Appt 15 – To define “Web Bookable” appointments for Doctor B.
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Providers who have multiple types of appointments at different time intervals

If one of your providers books several types of appointments that require different lengths of 
time, create a separate schedule time type for each length.

For example, a doctor requires 10-minute appointments for most of their general clinic 
visits,however they require 20-minute appointments for complete physicals. You could then 
create the following time types to accommodate each appointment length:

 Web Appt 10– To define “Web Bookable” appointments for general clinic visits.

 Web Appt 20– To define “Web Bookable” appointments for complete physicals.
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Steps

1. From the Appointment Scheduler menu, click Configure > Time Types. The Schedule 
Time Type Maintenance window opens. 

2. Click New ( ).

3. Enter information for the new Time Type, using the following table as a reference:
Field Description

Type Type the word or phrase you want to appear on the schedule. For 
example, for 10-minute “web bookable” slots, type Web Appt 
10.
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Level In the list, complete one of the following actions:

To make this time type available when defining each provider’s 
schedule, choose Service Provider.

To make this time type available only when defining clinic 
schedules (for example, holidays or office closed), choose Clinic.

Reason In the list, choose the default appointment reason to display on 
appointments booked in these time slots. For example, you can 
have the appointment reason default to Office Visit – Online.

Note: This list contains appointment reasons that are defined in 
the Appointment Reason Maintenance window. You can 
add or edit appointment reasons as needed. See 
“Enabling specific types of appointments to be booked 
online” on page 83.

Bookable Select this check box (if it is not selected already).

Non-Billable To ensure that appointments booked on these time slots are 
billed, leave this check box clear.

Default Appt 
Length 

In the list, click the default length for appointments booked on 
these time slots.

Note:  The appointment length should be compatible with the 
provider’s time slot intervals. For example, if a provider’s 
schedule is set to 10-minute intervals, then the set the 
interval to 10-minute or a multiple of 10-minute (for 
example, 20 minutes).

Set Color To display a background color on these time slots, click Set 
Color and choose the color you want. 

Print on Daysheet Select to print the schedule time type on your daysheets.

Note: Most clinics cleat this option, as they want only 
appointments to display on their daysheets.

Exclude From 
Reports 

Leave this check box clear, unless you want appointments 
booked on these time slots to be excluded from trend reports.

Warn if appts are 
within new 
definition 

Clear this check box (if it is not clear already).

Priority area 
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4. To save the time type, click Save ( ).

5. When you are done, click Close ( ).

Priority Enter the default priority level (usually 6 or 7) for the time type.

The priority determines what layer on the schedule that a time 
definition displays. The larger the priority number, the lower the 
layer on the appointment schedule. 

9 = lowest layer (displays behind all other layers)

1 = highest layer (displays in front of all other layers)

Click the  icon to view recommendations for assigning priorities 
to time types.

From 

To 

Enter the range of priority levels you can apply to the time type.

For example, if you want the default priority level to be 7, but you 
want to be able to customize it between 5 and 9, type 7 in the 
Priority field, type 5 in the From field, and type 9 in the To field.

Web Booking area (located at the bottom of the window) 

Web Bookable Select to enable patients to book their own appointments online 
on these appointment slots.

Note:  You must select this check box to enable appointments to 
be bookable from the patient portal.

Bookable from Enter the minimum number of minutes, hours, or days ahead of 
time patients can book online appointments on these 
appointment slots.

Prior to Enter the maximum number of minutes, hours, or days ahead of 
time a patient can book an online appointment for.

Appt Type Label Enter a label for the appointment type. The label typically matches 
the name entered in the Type field.

Web booking 
instructions 

Enter any booking instructions for the patient.
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Enabling specific types of appointments to be booked online

When a patient books an appointment online, they must select a reason for the appointment. 

You can customize this list of reasons, thereby specifying what types of appointments patients 
can book online.

Tip: To enhance the user experience, we recommend that you enable as many appointment 
types as possible for web booking.
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Steps

1. From the Appointment Scheduler, click Configure > Appointment Reasons. The 
Appointment Reason Maintenance window opens with a list of your current appointment 
reasons displayed. 

2. In the list of appointment reasons, click the Internal ID of an appointment reason for which 
you want to enabled online booking. The EMR displays the Data tab for the appointment 
reason.

3. If the appointment reason you want is not on the list, then add an appointment reason.

4. In the Web Booking area, select the Display in Web Appointment Reasons check box. 

5. In the Web Appt Reason Label field, type the appointment reason text that will display on 
the patient portal.

Note: Your patients will see the Web Appt Reason Label. Avoid using abbreviations or 
words that a patient may not understand. For example, use “Complete Physical” 
instead of “CPX”.
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6. Click Select Time Types. The Select Time Types window opens, with a list of “web 
bookable” schedule time types. 

Tip: The Select Time Types button displays only when you select the Display in Web 
Appointment Reasons check box.

7. Select the check box beside the time type(s) you want patients to be able to book this type 
of appointment.

Tip: Ensure that you select a time type(s) that matches the appointment length required 
for the Appointment Reason. For example, if the appointment reason is “Complete 
Physical”, and physicals require a 20-minutes appointment, ensure you associate 
the “Complete Physical” with the Web Appt – 20 time type.
If one provider spends a longer amount of time with their patients than another in the 
clinic, you can associate an appointment reason with multiple time types that are set 
for different appointment lengths. 

8. Click Save ( ).

9. When you are done, click Close ( ).

Enabling specific days and time slots for online booking

On your clinic’s appointment schedule, you can select what time slots your patients can book 
online. For example, you can choose to allow online appointment bookings only for times slots 
where your clinic typically sees fewer walk-in patients and is less busy.

Tip: To encourage your patients to book their appointments online, consider making as 
many of your appointment slots “web bookable” as possible. This will make it easier for 
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patients to find appointment times that work for them.

Steps

1. Create scheduling time types that are defined as “web bookable” (see “Creating “web-
bookable” schedule time types” on page 78“).

2. Apply the “web bookable” time types to a provider’s schedule, or to all providers’ schedules 
at once in the Time Definition Maintenance window.

3. To enable specific days and or time slots for online booking:

4. From the Appointment Scheduler menu, choose Configure > Physician and Clinic 
Hours (Schedule Setup). The Time Definition Maintenance window opens. 

5. If your clinic has multiple locations, in the Location list click the location you are enabling 
online appointments for.

Tip: To enable online appointments for the same time slots for all locations, choose 
<All>.

6. In the Service Provider list, choose the provider you want to enable online appointments 
for.

Tip: To enable online appointments for the same time slots for all providers, choose 
<Entire Office>.
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7. At the top of the window, click New ( ). The Definition Maintenance window opens. 

8. Using the following table, enter information for the web bookable time.
Entry label Instructions

Schedule Type In the list, click a schedule time type that is configured to be “web 
bookable”. See “Enabling specific types of appointments to be 
booked online” on page 83.

Day of the Week To input a time definition for each day of the week individually, click 
a day of the week. For example, Monday.

To input a time definition all days of the week at once, click <All>.

Web Booking In the list, select what patients can book appointments with this 
provider. 
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Time In the From and Up To fields, enter the start and end times for 
web-bookable time slots for the day selected (or for the week, if 
<All> is selected). 

For example, if you only want web-bookable appointments 
starting from 1 PM with the last web-bookable appointment 
ending at 3 PM, then enter 1 in the From Hour field and 00 in the 
From Min field, and then enter 15 in the Up to Hour field and 00 in 
the Up to Min field.
88 Wolf EMR Patient Portal User Guide



Managing the patient portal (Administrators)
Priority In the Priority field enter the priority level for the time definition. 

The priority determines what layer on the schedule the time 
definition displays. The larger the priority number, the lower the 
layer on the appointment schedule. 

 9 = lowest layer (displays behind all other layers)

 1 = highest layer (displays in front of all other layers)

Recommendation: For setting web-bookable time definitions set 
the priority to be a higher than the number you use for holidays, 
and provider Out of Office time definitions. A priority of 6 or 7 is 
used most often for web-bookable appointments. 

Important: Appointment slots are only web bookable if a web-
bookable Time Type is visible on the schedule.  If you “hide” a 
web-bookable Time Type with another Time Type, for example, 
“Out of Office”, then that appointment slot is no longer web-
bookable. 

Appointment 
Definition 

In the Reason list, choose the default appointment reason to 
display on appointments booked in these time slots. For example, 
the appointment reason can default to Office Visit – Online.

Note: Choose an appointment reason that is configured to 
“display in web appointment reasons”. See ““Enabling 
specific types of appointments to be booked online” on 
page 83”.

In the Length list, click the default length for appointments 
booked on these time slots.

Web-bookable slot is 
covered by “out-of-office”, 
therefore the slot is no 
longer web-bookable.
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9. Click Save ( ).

10.If you are adding time definitions for each day of the week individually, repeat these steps for 
each day of the week. 

11.When you are done, click Close ( ).

Modifying the booking pages’ legal messages and instructions

At each step of the online appointment booking process, your patients are presented with an 
instructional and/or legal message. When your clinic is set up with the patient portal, these 
instructional and legal messages are customized by TELUS Health to reflect your clinic’s current 
policies.

If you later want to modify the booking instructional and legal messages, you can modify the 
following messages as needed. 

Time Definition 
Time Period 

In the From and Up To (Not including) fields, enter the date 
range you want the hours you defined to be in effect.

Note: The From field defaults to today’s date. If you leave the Up 
To field blank, the time definition remains on the provider(s) 
schedule indefinitely.
If this time definition is to be in effect for only one day, enter 
the date in the Specific Date (1 Day Only) field.
90 Wolf EMR Patient Portal User Guide



Managing the patient portal (Administrators)
Book appointment legal message (Located at the top of all booking windows) 

Book Appointment Screen 1 Instructions
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Book Appointment Screen 2 Instructions - Location & Provider
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Book Appointment Screen 3 Instructions - Date & Time 
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Book/Cancel Appointment Cancellation Policy - Confirm Details 

Max booking reached message (when patient exceeds the max number of online 
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bookings

Steps

1. On the Wolf EMR Home page, click the Maintenance tab. 

2. In the Patient Portal area, click Configure Web Content ( ).
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3. In the left column, choose Appointment Content and then choose the book appointment 
message you want to modify. The EMR displays all current appointment messages on the 
right side of the window, with the selected page’s message highlighted. 

4. Edit the Book Appointment page message as needed. You can review and modify all your 
informational and legal messages at once by scrolling down and reviewing all legal 
messages displayed. 

5. Perform one of the following actions:

 To apply your changes to the patient portal and leave the window open, click Apply ( ).

 To apply your changes to the patient portal and close the window, click Save and Close 

( ). 

 To close the window without saving your changes, click Close ( ).

Configuring patient portal registration rules
You can set patient registration rules for the patient portal. Registration rules include:

 The minimum age a patient must be to register for the patient portal.

 The age of consent: Determines at what age a patient must consent (by signing a consent 
form) to enable another individual to view their health information on the patient portal. For 
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example, if a mother has access to her son’s health information, she can no longer access 
his health information when he reaches the age of consent, unless he signs a consent form. 
For more information, see “Giving other people access to a patient’s data” on page 11.

Steps

1. On the Wolf EMR Home page, click the Maintenance tab. 

2. In the Patient Portal area, click Configure Web Content ( ).The Patient Portal 
Content and Configuration Form window opens.

3. In the left pane, choose Registration Configuration > Registration Rules. 

4. Use the following table to enter information in the Registration Configuration area:
Field Description

Minimum age to 
register for patient 
portal 

Enter the minimum registration age in years. If you do not want to 
set an age restriction, then leave the field blank.

Minimum age of 
patient that 
requires consent 

Enter the age of consent in years.

Number of days 
before invitation 
PIN expires 

Enter the number of days a patient’s registration PIN is valid.

Enable Reminder 
Emails 

Select to send a reminder email when a patient was invited to 
register for the patient portal but has not yet registered.

Send first/second 
email reminder… 

Enter how long after the initial invitation to send the first and 
second reminder. We recommend 25 hours.
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5. Perform one of the following actions:

 To apply your changes to the patient portal and leave the window open, click Apply ( ).

 To apply your changes to the patient portal and close the window, click Save and Close 

( ). 

 To close the window without saving your changes, click Close ( ).

Configuring patient messaging

If your clinic sends messages to individual patients via the patient portal, you can choose if 
patients can send messages back to the clinic, how many message they can send, and the 
length in characters of their messages.

You can configure these settings for the entire clinic or per provider.

You can also temporarily disable your patients’ ability to send messages, for example, if your 
clinic is closed for a week.

You can also restrict how many messages a specific patient can send (see “Registering 
patients for the patient portal” on page 7). 

Note: If you prevent a patient from sending messages to a provider, but the patient has 
access to another provider’s patient data (such as their son) and this other provider 
does enable inbound patient messages, this patient will still be able to send messages 
to their provider. 

Steps

1. On the Wolf EMR Home page, click the Maintenance tab. 

2. In the Patient Portal area, click Configure Web Content ( ).
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3. In the left pane of the Patient Portal Content and Configuration Form window, click 
Messaging Configuration > Messaging Settings.  

4. Use the following table to enter information in the Messaging Configuration area: 
Field Description

Enable Reminder 
Emails 

Select to enable sending reminder emails. 

Send first/second 
email reminder… 

Enter how long after the initial email to send the first and second 
reminder. We recommend 25 hours.

Incoming 
Messages Go To 

Select the clinic default for who will receive incoming messages 
from patients. 

Disable Inbound 
Messages 

Select to prevent all patients from sending messages to the clinic.
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5. Perform one of the following actions:

 To apply your changes to the patient portal and leave the window open, click Apply ( ).

 To apply your changes to the patient portal and close the window, click Save and Close 

( ). 

 To close the window without saving your changes, click Close ( ).

Configuring automated notifications (Rules)

Through the patient portal, your patients can receive automated notifications for a variety of 
preventive care, or disease management reminders, including notifications for:

 Mammograms

 Pap smears

 Colonoscopies

 HbA1C tests

 Follow-up appointments

When a patient receives a notification on the patient portal, they are informed by email. This 
email does not contain any personal or medical information, it only prompts the patient to log 
into the patient portal to view the notification.

You create automated patient portal notifications using the Rules feature of Wolf EMR practice 
search. When you configure a rule to display in the patient portal, the EMR identifies all patient 

Default Maximum 
Patients can 
Compose 

To restrict the number of messages patients can send, type the 
maximum number of messages each patient can send over a 
specified number of months.

To enabled unlimited messages, type 999.

The maximum number of messages can also be customized for 
each patient. See “Registering patients for the patient portal” on 
page 7.

Maximum size of 
messages from 
Patients 

To restrict the length of messages patients can send, type the 
maximum number of characters.

Provider 
Messaging 
Settings 

To specify the messaging settings for a specific provider, select 
the provider and choose the settings. 
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portal-registered patients meeting the rule criteria and sends those patients a notification 
automatically.

Steps

1. On the Wolf EMR Home page, click Practice Search ( ). 

2. At the top of the Practice Search window, click Open a saved search ( ).

A list of pre-configured searches and rules opens. Rules are indicated by the word Rule in 
the Type column.

3. In the list of searches and rules, click a rule you want to configure as a patient portal 
notification.

Note: Your Wolf EMR comes with a large set of pre-defined rules, including
Rules for preventive care initiatives, including monitoring of BP, and immunizations.
Rules to manage patients with chronic diseases such as diabetes, COPD, asthma, 
hypertension, and depression.
To learn how to create a new rule, or to modify an existing rule, refer to the Wolf EMR 
Help menu. 
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4. In the Portal Notifications area, select the Display Rule Match in Portal check box, and 
then click Notification Settings. 

The Portal Notification Settings window opens. 

5. To have patients receive an email indicating that they have a notification waiting on the 
patient portal, select the Send Email Alert check box.

6. In the text area, type the notification message that patients will see in the patient portal.
For example, “Our records show that you are due for a routine Mammogram. Please contact 
our clinic to set up an appointment”.
102 Wolf EMR Patient Portal User Guide



Managing the patient portal (Administrators)
Tip: Use the formatting tools located above the text area to modify the font, add bullets 
or numbers, align the text, and add hyperlinks.

7. Click Save.

8. To exit the Open Save Search or Rule window, click Exit Menu.

9. To exit the Practice Search window, click Close ( ).

Tracking cancelled appointments
When patients cancel their appointments online, Wolf EMR does not notify you of the 
cancellations.

This can be problematic if your clinic charges patients for canceling their appointments less 
than 24 hours prior to their appointment. Instead, you must manually track canceled 
appointments. 

For appointments canceled online, you can:

 Track what patients have canceled their appointments in the last 24 hrs, or in a specified 
date range, using the Customized Appointment Report. See “Producing a report of 
cancelled appointments” on page 103.

 Set your appointment scheduler to show cancelled appointments. See “Setting your 
appointment scheduler to show cancelled appointments” on page 105.

Producing a report of cancelled appointments

You can produce a report of patients who have canceled their appointments less than 24 hours 
prior to their appointment. You can run this report as often as you want, for any time range you 
want.

Most clinics prefer to run the report daily.
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Steps

1. On the Appointment Scheduler menu, choose Report > Customized Appointment 
Report. The Appointment Report window opens. 

1. To select what information you want to display in the report, using the following table as a 
reference: 
Field Description

Date Options Choose Service date. In the From field, leave the date as 
today’s date. In the To field, enter tomorrow’s date.

This creates a report that includes cancelled appointments that 
would have taken place today or tomorrow.

Selection Options  Location: If your clinic has more than one clinic location, 
choose the location you want to view cancelled appointments 
for,.

 Selected Physician: Choose the provider you want to view 
cancelled appointments for. 

 Group by Primary: Choose an option for grouping (ordering) 
patients on the report.

 Group by Secondary: Choose an option for grouping 
patients within the primary groups.
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2. Complete one of the following actions:

 To view the report (without printing), click Preview. The EMR displays the report in a new 
window in the format of a PDF document.

 To print the report, in the Name list, choose a printer. In the Copies field, type the 
number of copies and then click Print.

Setting your appointment scheduler to show cancelled appointments

You can show cancelled appointments on the appointment scheduler.

Steps

1. On the Appointment Scheduler menu, choose User Preferences > Appointment 
Display Settings > Show Cancels. T
Cancelled appointments appear on the schedule with XX to the left of the patient names. 

Display Options  Show address: (Optional) Select to display patient addresses 
on the report.

 Show phone numbers: (Optional) Select to display patient 
phone numbers on the report.

 Hide Patient Identifier: (Optional) Select to hide the patient’s 
Wolf EMR ID number.

Special Options To view only canceled appointments that were originally booked 
on the patient portal, select the Web booked only check box.

Cancellations  Include cancellations: Select this check box.

 Show Cancellations only: Select this check box.

Choose one of the following options:

 Less than 24 hrs: (Most Common) to view cancellations that 
occurred less than 24 hrs before the appointment time/day.

 Greater than 24 hrs: To view cancellations that occurred 
more than 24hrs prior to the appointment time/day.

 <All Cancellations>: To view all cancellations that occurred 
for appointments booked for dates specified in the Date 
Options area.
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If an appointment is booked on the same time slot as a cancelled appointment, the EMR 
adds additional appointment lines to show both. 

2. To view detailed information about a canceled appointment, right-click the appointment, and 
choose Edit. 

Patient portal reports
Using a practice search and Wolf EMR reports, you can track and manage patients who are 
using the patient portal. For example, you can track:

 Which patients are enrolled or registered for the patient portal

 Which patients have been actively using the patient portal

 What patient portal features each registered user has access to

 Which patients have unread messages

Statistics for enrolled patients, appointments booked, and automated notifications 

Viewing patients who are registered for the patient portal

Using a practice search, you can produce a list of patients who are enrolled and/or registered 
for the patient portal. You can further filter the report to include only patients who:

 Logged in during a specified time period

 Have access to specific features of the patient portal (for example, online appointment 
booking, and video visits)

 Have a status of inactive
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Steps

1. On the Wolf EMR Home page, click Practice Search ( ). The Practice Search 
window opens.  

2. At the top of the window, click Make New Search (Remove all parameters) ( ).

3. In the top field, enter a name for the report, such as Registered patient portal Patients.

4. In the left pane, under Select Search Parameters, expand patient portal. 
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5. In the list of patient portal parameters, click Portal Status. The Show Patients with Portal 
Status area appears in the right pane. 

6. Using the following table, select the specific parameters patients must meet to display in the 
report. 
Field Description

Enrolled Date To include only patients who were enrolled for the patient portal 
before, following, or around a specific date or time frame:

1. Select the Enrolled Date check box.

2. In the list, select a time frame option. The EMR displays 
additional entry fields specific to the time frame option you 
select. 

3. Enter a date or time frame as required.
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Registration 
Date 

To include only patients who registered for the patient portal before, 
following, or around a specific date or time frame:

1. Select the Registered Date check box.

2. In the list, select a time frame option. The EMR displays 
additional entry fields specific to the time frame option you 
select. 

3. Enter a date or time frame as required.

Last Login Date To include only patients who logged into the patient portal before, 
following, or around a specific date or time frame:

1. Select the Last Login Date check box.

2. In the list, select a time frame option. The EMR displays 
additional entry fields specific to the time frame option you 
select. 

3. Enter a date or time frame as required.

Health 
information 

To include only patients who have their health information (Medical 
Summary information) enabled or disabled:

1. Select the Health information check box.

2. In the list, select to include only patients who have health 
information Enabled or Disabled.  

Online Appt 
Booking 

To include only patients who have online appointment booking 
enabled or disabled:

1. Select the Online Appt Booking check box.

2. In the list, select to include only patients who have online 
appointment booking Enabled or Disabled.

Notifications To include only patients who have automatic notifications enabled or 
disabled:

1. Select the Notifications check box.

2. In the list, select to include only patients who have notifications 
Enabled or Disabled.
Wolf EMR Patient Portal User Guide 109



Managing the patient portal (Administrators)
7. To exclude patients who meet the criteria defined in step, above the Show Patients with 
Portal Status area, select the Exclude Matches check box.

8. To include all providers’ patients in the report, at the top of the window, select the Search 
All Patients check box.

9. Click Show Search Results as a Patient List ( ). A list of matching patients appears. 

Viewing patients who have read or unread patient portal messages

Using Practice Search you can produce a list of patients who have received messages via the 
patient portal. You can further filter the report to display only patients who have unread 
messages.

Account Status To include only patients who have a status of active or inactive:

1. Select the Account Status check box.

2. In the list, select to include only patients who are Active or 
Inactive.

Video visits To include only patients who have been enabled or disabled for 
video visits:

1. Select the Video Visits check box.

2. In the list, select to include only patients who are Enabled (but 
not Qualified), Qualified, or Disabled for video visits.

Note: Patients are qualified for video visits only after they have 
passed video device testing.
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Steps

1. On the Wolf EMR Home page, click Practice Search ( ). The Practice Search 
window opens. 

2. At the top of the window, click Make New Search (Remove all parameters) ( ).

3. In the left pane, under Select Search Parameters, expand Patient Portal. 

4. In the list of patient portal parameters, click Published Messages. The Show Patients 
with Published Messages area appears in the right pane.

5. Using the following table, select the specific parameters patients must meet to display in the 
report.
Field Description

Read Date To include only patients who read a message before, following, or 
around a specific date or time frame:

1. Select the Read Date check box.

2. In the list, select a time frame option, the EMR displays additional 
entry fields specific to the time frame option you select. 

3. Enter a date or time frame as required.
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6. To exclude patients who meet the criteria defined in the above table, above the Show 
Patients with Published Messages area, select the Exclude Matches check box.

7. To include all providers’ patients in the report, at the top of the window, select the Search 
All Patients check box.

8. Click Show Search Results as a Patient List ( ). A list of matching patients appears.

Monitoring patient portal usage

If you want to know how many of your patients are enrolled on the patient portal, and how your 
patients are using the patient portal, you can view and save statistics on patient portal usage. 
You can view reports for:

 Logins

 Appointments booked

 Notifications

 Enrolled users

Steps

1. On the Wolf EMR Home page, click the Reports tab. 

2. On the Reports toolbar, click Usage Metrics. 

Read Status To include only patients who have read or unread messages:

1. Select the Read Status check box.

2. In the list, select to include only patients that have Read or Unread 
messages.  
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3. From the list of statistics reports, double-click the report you want. A report filtering window 
opens. 

Note: The filtering window may have different options depending on the report you are 
producing.

4. Using the following table, select the information you want to view. 
Filtering area Instructions

Date Range Enter the start date and end date for which you want to view 
statistics for.
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Appointment date 

Booking date 

If you are producing a report for Appointments Booked, below 
the Date Range area, click one of the following options:

 Appointment Date: To limit the date range by date of 
scheduled appointment.

 Booking Date: To limit the date range by date of appointment 
booking. 

Providers Select the check box beside the provider(s) whose patients you 
want to view statistics for.

To include statistics for patients whose primary provider is now 
inactive, select the Include Inactive Providers check box.

Tip: To view patient portal statistics for all providers at once, in the 
Providers area, click Select All. The EMR automatically selects 
all providers listed.

If all providers are selected, but you only want to view statistics for 
one or two, in the Providers area, click Clear. The EMR 
automatically clears the check box beside all providers listed. You 
can now select the check box beside the provider(s) you want.

Locations Select the check box beside each location you want to view 
statistics for.

Tip: To view patient portal statistics for all locations at once, in the 
Locations area, click Select All. The EMR automatically selects 
all locations listed.

If all locations are selected, but you only want to view statistics for 
one or two, in the Locations area, click Clear. The EMR 
automatically clears the check box beside all locations listed. You 
can now select the check box beside the location(s) you want.

Note: : This option is not available for the Notifications report.
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Patients To view statistics for only one patient:

1. In the drop-down list in the Patient area, click the patient you 
want to view statistics for.

2. If the patient list is extensive and you cannot find the patient 
you want, in the top row of the patient list, enter the patient’s 
last name. The EMR filters the list to display only matching 
names.  

3. Click the patient you want to view statistics for.

4. To include patients who do not have a primary provider defined 
in the Patient Maintenance window, select the Include 
Patients without Provider check box.
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5. Click Run Report. The EMR displays a preview of the report. 

6. To save (export) the report in a specific format, click File > Export Document and choose 
a file format. Select the export options you want, and then click OK.
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